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Welcome to ACDSee Luxea Video Editor

Luxea is video editing software that puts the power in your hands.
Create incredible videos in a variety of formats including MP4, WEBM, MOV, M4V, GIF, and MP3. Produce content
using video, images, and audio files. Get creative with editing by adding transitions, captions, filters, animations,
and more. Customize your video to show off your own unique style and then upload it straight to YouTube or
Vimeo. Want to show your work to your friends and followers? Share directly to Facebook or Twitter as you upload.
This help file is here to enable you to navigate Luxea and utilize its features to create your best videos. If you have
any questions about the product and its features, you may find the answer in our forum.
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Creating, opening, saving, and sharing projects
When you first open Luxea, you can begin adding media without opening a new project. After you have finished
this project, you may wish to begin a new one without closing the application. This is also helpful if you have
opened Luxea to a half-finished project, but want a fresh start.

Creating and opening projects
To create a new project:
Go to File | New Project or press Ctrl + N.
To open an existing project:
Go to File | Open Project... or press Ctrl + O.
To open a recent project:
1. Go to File | Recent Projects.
2. Choose your desired project from the list of the ten most recent projects.
To import a zipped project from another user:
1. Go to File | Import | Zipped Project... or click Ctrl + E.
2. In the Import Zipped Project File dialog, use the ... button to navigate to the zipped project file on your
hard drive.
3. In the next field, use the ... button to navigate to a location for the unzipped project.
4. Check the Open project after import checkbox to launch the project.
5. Press OK.

Saving projects
To save a project:
To save a project, do one of the following:
Go to File | Save Project, enter a name for your project, and press Save.
Press Ctrl + S.
To save your project under a new name, go to File | Save Project as.... Enter a name and press Save.
Exit Luxea. If you have not already saved, or have made changes since your last save, you will be asked if
you want to save your project. Select Yes, enter a name, and press Save.

Press the Save icon in the top right.

Sharing projects
To share a project:
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You can share your project with other users running Luxea by exporting it as a zip file. The other user will import
your zip file into their copy of Luxea and all of the elements of your project (except downloadable content) will
display on the Timeline in the same layout as you saved it.
To export your project as a zip file:
1. Go to File | Export Zipped Project....
2. In the Export Project as Zip dialog, enter a name for your zipped project file, or press the ... button to
select a new location and enter a name.
3. Check the Include all files from My Media in zip checkbox to ensure the media in your project is
useable for the other user.
4. Press OK.
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Adding and removing media
You can add media from your hard drive to My Media, and then place it on the Timeline for editing and production.
You can add video, image, and sound files. These files can be referred to as clips or media. There are two tabs in
the Media section which act as repositories for your media. My Media contains files you have imported to use in
your projects. Library contains content from Content Packs that you have downloaded and imported from ACDSee.
To find out more about Content Packs, see Using Content Packs to enhance your media.
To add media to My Media:
1. Click the Media tab or press M.

2. To add media to My Media, do one of the following:
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Go to File | Import | Media...

Click the Import Media button at the bottom right of My Media.
Press the Import Media... button in the My Media pane.
Press Ctrl + M.
Drag your media files from Windows Explorer directly into My Media or onto the Timeline.
3. In the Add Media Files dialog, browse to and select your media, or use Ctrl + click to select specific files,
Shift + click to select multiple files, or click + drag around files to select multiple files.
4. Press Open.
You can use the Sort menu to sort your added media by File Name, File Size, Media Type, or Modified
Time. Right-click a file to access the context menu, then choose Sort By.

To add media to the Timeline:
To add media to the Timeline, do one of the following:
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1. Right-click the media you want to add to the Timeline.
2. Select Add to Timeline at Playhead from the context menu. Continue this action for all media you would
like to add. Select and drag the edge of the clip to specify the desired duration.
Or:
1. Select the media you want to add to the Timeline.
2. Drag it onto your desired location on the Timeline. Select and drag the edge of the clip to specify the
desired duration.
Or:
1. Select the media you want to add to the Timeline.
2. Press Alt + A. The clip will be added to the Timeline at the Playhead's current position.
You can also move multiple clips from My Media to the Timeline at once by dragging your cursor over the
clips and then dragging them onto the Timeline. Or, you can hold Shift while you select clips, and then
drag them onto the Timeline.

The Timeline makes it easy to keep track of your video's duration at a glance. You can hover your cursor
over a clip on the Timeline to see its duration data. Please note that the first five digits represent time.
However, the last two digits (after the semi-colon) represent frames, rather than milliseconds. There are
up to 60 frames per second.

To remove media from My Media:
To remove media from My Media, do one of the following:
Right-click the media you would like to remove. Select Remove from My Media from the context menu.
Select the media in My Media and press Delete.
To remove all media from My Media, do one of the following:
Go to Edit | Remove All from My Media.
Press Ctrl + Alt + R.
To remove all media not added to the Timeline:
You can remove all media from My Media that you have not added to the Timeline.
Right-click anywhere in My Media and choose Remove Media not on Timeline from the context menu.
To remove media from the Timeline:
You can remove an individual clip by right-clicking it on the Timeline and selecting Delete.
To remove all of the clips on the Timeline, go to Edit | Remove All from Timeline.
Previewing media:
To preview media in My Media, do one of the following:
Right-click the file and choose Preview... from the context menu.
Select the clip and press Alt + P.

You can press F to display the preview full screen, or by pressing the Full Screen button.
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Organizing, adjusting, and displaying media
On the Timeline, you can arrange your media on tracks to create and edit your video. Using multiple tracks allows
you to layer content. You can add as many tracks to the Timeline as you want. You can drag and drop video, audio,
and images from My Media to any track on the Timeline, anywhere you like. You can also drag text, transitions,
audio effects, animations, behaviors, filters, overlays, and advanced effects to specific locations on your media on
the Timeline, or on the track above your media. Captions will be added at the Playhead. Once on the Timeline, you
can move media to the location you desire by selecting and dragging.

Timeline tracks
You can use the tracks on the Timeline to create a layered hierarchy of content. For instance, if you have a video or
image on Track 1, but then add another video or image on Track 2, the video or image on Track 2 will cover the
video or image on Track 1. However, you can alter the way in which media appears by adjusting its opacity and
blend mode. Opacity describes how transparent the media is. By altering the opacity of media on Track 2, you can
allow media on Track 1 to show through. Blend modes describe how the layers blend together.
To adjust media properties:
1. Select media on the Timeline.

2. Click the Properties button in the top right corner.
3. Adjust the settings as described below.

Properties pane options
Blend Mode

Use the effects in the Blend Mode drop-down menu to control how your
media blends with the media or background below it. If your media is
not stacked on one or more tracks, blend modes will blend the media
with the background. By default, the background is black, however, you
can change the color of the background in the Project Settings. For
more information, see Display Area below.

Opacity

Use the Opacity slider to change the opacity of your media.

Rotation

To rotate your video or media, enter a value in the field or drag the
arrow handles to rotate your media by the X, Y, or Z axes.

Position

Enter a value in the X and/or Y fields, or drag the clip around in the
Display Area to change its position.
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Copying and pasting properties
You can copy the blend mode, opacity, position, and rotation values of clips on the Timeline and paste them to
other clips on the Timeline.
To copy and paste properties:
1. Right-click a clip on the Timeline with blend mode, opacity, position, and rotation values you would like to
copy.
2. Choose Copy Properties from the context menu or press Ctrl + Alt + C.
3. Select another clip on the Timeline.
4. Right-click and choose Paste Properties or press Ctrl + Alt + P.
Locking tracks:
You can lock any track to prevent editing or other changes being made to the media on it by pressing the Lock
button.

To unlock the track, press the Lock button.

Hiding tracks:
You can hide and reveal tracks, and by extension the media on those tracks, by pressing the Disable button on
the track.

This can help you to isolate and edit specific parts of your video.

Please note that video productions will not include media on tracks set to Disabled.
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Closing gaps on the Timeline
You can remove empty spaces between media on the Timeline by using Close Gaps on Track.
To remove the empty space on a track:
1. Right-click an empty area on a Track in the Timeline.
2. Choose Close Gaps on Track from the context menu.
To remove the empty space between multiple pieces of media:
1. Select multiple pieces of media in a Track on the Timeline.
2. Right-click on one of the selected media.
3. Choose Close Gaps from the context menu.

Playback quality
You can adjust the video playback quality to help you speed up your editing process. This is useful if you are
working with high quality videos or your computer is processing the video slowly.
To change playback quality:
To change playback quality, do one of the following:

Click on the drop down menu beside the seek bar

and choose a quality.

Go to View | Playback Quality and choose one from the list.
Changing the playback quality will not affect the quality of the final output.

Full screen playback
You can view your video playback in full screen to see your video in more detail.
To view playback in full screen:
To view the video playback in full screen, do one of the following:
Go to View | Display Area and click Full Screen/Restore.
Press F.

Click the Full Screen button.

Display Area
You can use the Display Area to preview how your video will look once rendered. You can move your content
around and resize it within the Display Area. You can resize by dragging the handles on the edges of the media. To
resize while maintaining the aspect ratio, use one of the corner handles. To create an abnormal aspect ratio, hold
down Shift while dragging the corner handles.
You can zoom the Display Area to accommodate your monitor size using the percentages in the drop-down menu
at the top of the Display Area. Choose Fit to allow Luxea to adapt automatically. You can also detach the Display
Area to make editing easier. This is useful if you edit using two screens, or want to view your edits in full screen.
To detach the Display Area:
To detach the Display Area, do one of the following:
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Go to View | Display Area and click Detach Display Area.
Choose Detach Display Area from the drop-down menu at the top of the Display Area.

Above the Timeline Toolbar, click the Detach Display Area button.

To reattach the Display Area:
To reattach the Display Area, do one of the following:
Click the drop-down menu at the top of the Display Area and choose Reattach Display Area.
In the Display Area, press the Reattach Display Area button.
Close the detached display area.
To configure the Display Area settings:
To configure the Display Area settings for your project and resulting video production, do one of the following:

Click the Project Settings button at the top of the Display Area.
Click the drop-down menu at the top of the Display Area and choose Project Settings.
Configure the settings as described below and press Apply.
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You can also change the size settings for your rendered video in the Detailed Settings dialog in the
Production Assistant.

Project settings
Display Area Dimensions

Choose dimensions for the Display Area from the drop-down menu, or
choose Custom to specify a unique width and height. You can also
choose preset dimensions for social media channels TikTok and
Instagram.

Width/Height

Resizes the Display Area when Custom is selected from the Display
Area Dimensions drop-down menu.

Color

Customize the Display Area background color by selecting a color from
the drop-down menu.

Frame Rate

Choose a Frame Rate for your video from 23.97 frames per second
(fps) to 60 fps.

Media tools
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Pan tool: use the Pan tool to move the Display Area
without resizing it.

Press Ctrl + Shift + P.

Edit tool: use the Edit tool to move and resize media
within the Display Area.

Press Ctrl + Shift + E.

Crop tool: use the Crop tool to remove unwanted parts
of your media. Drag the handles of the crop window to
your desired size. To maintain your media's aspect
ratio, resize the crop window by dragging the corners.
You can also move the crop window around. To restore
cropped material, simply re-enter the Crop tool and
resize the crop window as desired.

Press Ctrl + Shift + C.
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Using the Timeline Toolbar
The Timeline Toolbar has a number of functions you can use to edit your video.
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Zoom in/Zoom out

Zoom in to expand the appearance of your
tracks on the Timeline, allowing for
precision editing. Zoom out to condense the
appearance of your tracks on the Timeline,
to view your project in its entirety. Or press
Ctrl + Shift + = or Ctrl + Shift + -.

Zoom to fit timeline

Zoom in or out to see your the entire length
of your track on the Timeline, to give you a
sense of the bigger picture. Or press Ctrl +
Shift + F.

Undo

Use the Undo button to undo your actions.
Or press Ctrl + Z.

Redo

Use the Redo button to repeat the most
recent actions that you undid. Or press Ctrl
+ Y.

Split

Use the Split button to divide one clip into
two or more clips. This allows you to insert
transitions and other clips between two
scenes.
Select the clip you want to split and press
the Split button. Or press Ctrl + Shift +
S.

Cut

Use the Cut button to remove unwanted
clips or sections of clips. (See Split.) You
can then paste them using the Paste button.
(See Paste.)
Select the clip you want to remove, then
press the Cut button. Or press Ctrl + X.

Copy

Use the Copy button to duplicate tracks or
sections of tracks. (See Split.) You can then
paste them using the Paste button. (See
Paste.)
Select the clip you want to copy, then press
the Copy button. Or press Ctrl + C.

Paste

Use the Paste button to add cut or copied
clips to your desired locations on the
Timeline.
After copying or cutting a clip, put the
Playhead where you want to paste, and
press Paste. Or press Ctrl + V.
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Seek to left/right
selection slider

Use the Seek to left selection slider button
to find the start of your selection on the
Timeline. Use the Seek to right selection
slider button to find the end of your
selection on the Timeline. This is useful if
you are viewing the Timeline zoomed in, or
if you are working with a large selection.

Seek to Playhead

Use the Seek to Playhead button to find the
Playhead on the Timeline. This is useful if
you are viewing the Timeline zoomed in.
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Move Playhead to the
start/end of Timeline

Use these buttons to move the Playhead to
the beginning of the Timeline (Page Up) or
to the end of the media on the Timeline
(Page Down).

Add Tracks

Use the Add Tracks button to add as many
tracks to the Timeline as you like.

Cut, Copy, and Paste can also be accessed by right-clicking on the Timeline.

These functions can also be accessed using keyboard shortcuts.
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Creating selections
The selection feature enables you to choose sections of your clip to delete, move or produce. You can produce a
section of a your clip, rather than the entire project, by creating a selection. This can be useful if you are creating
a trailer or you wish to produce one scene of a whole project.
To create and produce a selection:
1. With your desired media on the Timeline, pull the green selector (on the left of the Playhead) to where you
want the selection to start. Then pull the red selector (on the right of the Playhead) to where you want the
selection to end.

If the Selection sliders are out of sight, press the Seek to left selection slider button to find the start
of your selection. Press the Seek to right selection slider button to find the end of your selection.
2. Right-click your selection and choose Produce Timeline Selection as... from the context menu.
3. Configure your production settings in the Production Assistant.
You can also play your selection by placing the Playhead before your selection on the Timeline.

Deleting selections
To delete a selection:
You can delete selections of clips, essentially cutting the selection out of the clip.
1. Use the red and green selectors to select the area of your clip you wish to remove.
2. Right-click the clip and choose Delete.
To delete and fill a selection:
You can delete selections of clips and Luxea will fill in the gap by moving the surrounding media.
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1. Use the red and green selectors to select the area of your clip you wish to remove.
2. Right-click the clip and choose Ripple Delete.
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Luxea keyboard shortcuts
You can use the following keyboard shortcuts to expedite your video editing process.
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Shortcut

Resulting action

Ctrl + N

Creates a new project.

Ctrl + O

Opens the Open dialog.

Ctrl + S

Saves the project.

Ctrl + P

Launches the Production Assistant.

Ctrl + R

Launches the ACDSee Video Recorder.

Ctrl + W

Closes Luxea.

Ctrl + M

Opens the Add Media files dialog.

Ctrl + E

Opens the Import Zipped Project File dialog.

Alt + O

Opens the Options dialog.

M

Opens My Media.

Project management

Editing
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Ctrl + Z
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Undo
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Ctrl + Y

Page 22 of 76

Redo
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Ctrl + X
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Cut
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Ctrl + C
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Copy
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Ctrl + V

Paste

Delete

Delete

Ctrl + Delete

Ripple Delete.

Ctrl + Shift + S

Split

Ctrl + Shift + E

Activates the Edit tool.

Ctrl + Shift + P

Activates the Pan tool.

Ctrl + Shift + C

Activates the Crop tool.

=

Zooms in.

-

Zooms out.

Ctrl + Shift + =

Zooms into the Timeline.

Ctrl + Shift + -

Zooms out of the Timeline.

Ctrl + mouse wheel

Zooms in or out of the Timeline.

Alt + =

Expands the height of the Timeline.

Alt + -

Reduces the height of the Timeline.

Ctrl + A

Selects All.

Ctrl + D

Deselects All.

Page Up

Jumps Playhead to beginning of Timeline.

Page Down

Jumps Playhead to end of Timeline.

Left Arrow

Move the Playhead back one frame on the
Timeline.

Right Arrow

Move the Playhead forward one frame on the
Timeline.

Up Arrow

Jump backwards to the beginning or end of the
next piece of media.

Down Arrow

Jump forwards to the beginning or end of the
next piece of media.

Ctrl + Alt + C

Copies the properties of the selected media.
These properties include blend mode, opacity,
position, and rotation settings.

Ctrl + Alt + P

Pastes properties onto the selected media.

Ctrl + 2

Toggles the Properties pane open and closed
for the selected clip.

Ctrl + 1

Shows or hides the Content Pane.

Ctrl + Alt + T

Removes everything from the Timeline.

Ctrl + Alt + R

Removes all media from My Media.

Ctrl + Alt + S

Removes all captions.

Shift + C

Adds a caption to the Timeline.

F

Opens project to view in full screen.
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With media selected in My Media...
Alt + A

Adds the media to the Playhead's current
position on the Timeline.

Alt + P

Launches a preview of the media.

Alt + T

Opens the Media Details dialog.

Ctrl + Alt + O

Opens the file location of the media.

M

Opens the Media tab.

T

Opens the Text tab.

R

Opens the Audio Recorder tab.

S

Opens the Transitions tab.

D

Opens the Audio Effects tab.

A

Opens the Animations tab.

B

Opens the Behaviors tab.

L

Opens the Filters tab.

O

Opens the Overlays tab.

C

Opens the Captions tab.

E

Opens the Advanced Effects tab.

Shift + S

Takes a snapshot of your media's current
playback.

F1

Opens the online help.

Tools and effects

With a clip selected on the Timeline...
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Spacebar

Plays or pauses the media on the Timeline.

Alt + M

Mutes media during playback.

Alt + F

Creates a still image or Freeze Frame at the
Playhead's position on the Timeline. You can
customize how long the freeze frame will last.

Alt + A

The selected clip's audio switches to an
editable state. See Adjusting Audio.

Alt + S

Separates the selected clip's audio and video.
The audio will be moved to the track above. See
Adjusting Audio.

Alt + C

Adds the Clip Speed effect to the selected clip.

Alt + Left Arrow

Adds all media to the left of the selected clip to
the current selection on the Timeline.

Alt + Right Arrow

Adds all media to the right of the selected clip
to the current selection on the Timeline.

Left Arrow

Move the Playhead back one frame on the
Timeline.

Right Arrow

Move the Playhead forward one frame on the
Timeline.

Ctrl + Left Arrow

Shifts the media in the Display area one unit to
the left. The unit depends upon your level of
zoom.

Ctrl + Right Arrow

Shifts the media in the Display area one unit to
the right. The unit depends upon your level of
zoom.

Ctrl + Up Arrow

Shifts the media in the Display area one unit
up. The unit depends upon your level of zoom.

Ctrl + Down Arrow

Shifts the media in the Display area one unit
down. The unit depends upon your level of
zoom.

Ctrl + Shift + Left Arrow

Move playhead to beginning of previous media
on Timeline.

Ctrl + Shift + Right Arrow

Move playhead to beginning of next media on
Timeline.

Ctrl + Alt + E

Expands the height of clips on the Timeline
which have applied filters in order to expose
the filter bars for adjustment. See Adding
Filters to Your Media.

Ctrl + Shift + L

Rotate clip 90 degrees to the left.

Ctrl + Shift + R

Rotate clip 90 degrees to the right.
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Creating video recordings
You can record your screen, record with your webcam, and add your recorded clips to the Timeline, all using the
ACDSee Luxea Video Recorder.
To launch Luxea Video Recorder:
To launch Luxea Video Recorder, do one of the following:

Press the Record button in the top left corner of ACDSee Luxea Video Editor.
Press Ctrl + R.

To record your screen:
1. Configure your desired settings in the recorder window. See the Recorder Options section below.

2. In the top right corner, press the REC button or press F9.
3. To stop recording, press F10. (To change this keyboard shortcut, see the Hotkeys section in the
Recording Options table below.)
4. In the Save File dialog, enter a name for your recording and press Save.
5. Find your recorded clip in My Media.
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During recording:
You can toggle the Pause/Resume button to start and stop your recording.

To save your recording, press the Save button.

To cancel recording, press the Delete button.

Recorder options
Setting the recorder window options:
Select the drop-down menu next to the Dimension section, then choose the dimensions of your recording area.
When using a dimension other than Full Screen, you can drag the marquee handles to adjust the recording area to
your desired dimensions.

You can also enter a value in the Width and Height fields. Use the Link button to lock or unlock the aspect ratio of
your recording's dimensions.
Webcam recording:
To enable webcam recording, toggle the On/Off switch in the Webcam section. Select your device from the dropdown menu.
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To disable webcam recording, toggle the On/Off switch in the Webcam section.
You cannot record with a webcam when screen recording is not in progress.
Audio recording:
To enable audio recording, toggle the On/Off switch in the Microphone section. Select your audio input device from
the drop-down menu.

To disable audio recording, toggle the On/Off switch in the Microphone section.
System Audio recording:
To enable or disable system audio, toggle the On/Off switch in the System Audio section.

Annotations:
To add annotations to your recording, enable the type of annotation you would like to add, as described in the
Recording Options table below. Then do one of the following:
To add the date and time to your recording, go to Tools | Annotations | Add System Time Stamp.
To add a caption to your recording, go to Tools | Annotations | Add Caption.
To add a watermark to your recording, go to Tools | Annotations | Add Watermark.

Recording options
To set the recording options, go to Tools | Options.... On the Options dialog, configure the settings as described
below.
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General
General
Settings

Annotation

Record

Disable
screensaver
during
recording

Temporarily disables your
screensaver, which is
useful for longer
recordings.

Saving

Output
directory

You can select the location
where you would like the
recorded clip to be placed.

Prompt when
saving file

When you have finished
recording, Luxea Video
Recorder checks that you
would like to save it.

Temporary storage
folder

Temporary files will be stored here by the
recorder to assist with the creation of the
recording. They will be deleted as soon as you
save or cancel your recording. To change where
the temporary files will be stored, press the
Browse button.

Hardware
Acceleration

Enable
hardware
acceleration

Enabled by default, this
option ensures that the
encoding process will be
undertaken by your
graphics card, rather than
your CPU. This will
accelerate the media
rendering process. If
presented with multiple
graphics cards, Luxea
Video Recorder will
prioritize hardware
acceleration options using
the following hierarchy:
NVIDIA, Intel® Quick Sync.

Configure options for annotations. To add an annotation, go to Tools | Annotations | Add
[System Time Stamp/Caption/Watermark].
System Time
Stamp

System Time Stamp

Position

Text

Select a square to indicate
where on the screen you
would like the date and time
to appear.
Press the Font button
to configure the font,
size, style, and color.
Press the Background
color button to choose
the background color
to appear behind your
date and time.
For no background
color, check the
Transparent
background
checkbox.

Preview

Page 31 of 76

Displays the date and time

ACDSee Luxea Video Editor User Guide

as it will appear on your
recording.
Caption

Caption

Enter the text for your caption.
Position

Text

Select a square to indicate
where on the screen you
would like the caption to
appear.
Press the Font button
to configure the font,
size, style, and color.
Press the Background
color button to choose
the background color
to appear behind your
date and time.
For no background
color, select the
Transparent
background
checkbox.

Watermark

Watermark

Preview

Displays the caption as it
will appear on your
recording.

Prompt before
recording

When you press the Record
button, Luxea Video
Recorder will confirm the
caption you would like to
add.

Browse to the file you want to use as your
watermark.
Position

Select a square to indicate
where on the screen you
would like the watermark to
appear.

Opacity

Drag the Opacity slider to
specify the transparency of
the watermark.

Limit screen
recording
frame rate

Select the screen record
frame rate to determine
how quickly the picture
refreshes.

Input
Input Settings

Video

While it is possible
to limit the frame
rate during
capture, you will
not achieve a
higher quality by
setting the frame
rate above your
computer's
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capabilities.
Hotkeys

You can set keyboard shortcuts for your recording process.
Hotkey
Settings

Webcam

You can select the checkboxes and/or use the
drop-down menu to indicate what you want
your hotkey(s) to be for starting a recording,
and pausing and resuming a recording in
progress.

Save

You can select the checkboxes and/or use the
drop-down menu to indicate what you want
your hotkey(s) to be for saving your recording.

Configure options for your webcam recording.
Webcam
Settings
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Start/Resume/Pause

Webcam

Position

Select a square to indicate
where you would like your
webcam recording to
appear on your screen
recording.

Size

Move the slider to set the
size your webcam recording
will appear on your screen
recording.
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Adding text to your media
You can add text to your project. This is useful for providing additional information to your viewers, such as
introducing new scenes. You can also choose different effects for your text to make it more interesting. You can
apply Transitions, Animations, Behaviors, Filters, Chroma Key, Color LUT and/or Color Pass to your text. Using
Transitions, you can make your text fade in and out from clip to clip. See "Fading text in and out".
To add text to your images or videos:
1. Click the Text tab or press T to see a list of Text Styles.

2. Select the Text Style you would like to use and drag it to your desired location on the Timeline. You can
also right-click on the Text Style you would like to use and click Apply or press Alt + A.
3. A text box will open beneath the Display Area where you can edit the text displayed and its styles. On the
right hand side, you will see settings where you can change font, color, size, style, Text Effects, direction,
and alignment.
Within the Display Area, you can adjust the size and orientation of your Text using the mouse.

Creating Custom Text Styles
You can customize Text Styles and save them as presets for future use.
To create a custom text preset:
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1. In the text settings, press the Save as Custom button.
2. In the New Preset dialog, enter a name for your text preset.
3. Press OK.
To delete a custom text preset:
Select the custom text preset in the Text tab and press Delete.
To delete text:
Right-click the text on the Timeline and choose Delete.

Text Effects
You can add effects to your text.
To add Text Effects:
1. In the text settings, press the fx button.
2. In the Text Effects dialog, check the checkboxes of your desired effects.
3. Configure the settings as described in the Text Effects options table below.
4. Press OK.

Batch Text Edit
You can edit multiple pieces of Text in your media.
To use Batch Edit Text:
1. Select multiple pieces of Text on the Timeline by using Ctrl + Click or by clicking and dragging a box
around them.
2. Right-click and select Batch Edit Text...
3. In the Batch Edit Text dialog, select the relevant edits you wish to apply to all selected text. In the General
tab, you can edit fonts, color, size, style, direction, alignment and position. For advanced options, use the
Text Effects options table below as a guide.

Text Effects options
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Inner
Glow

Blend
Mode

Specifies how the effect blends with the text. Select a blend mode from the drop-down
menu.

Color

Specifies the color of the glow. Click the color picker to select a different color.

Thicknes
s

Specifies the thickness of the glow effect. Drag the slider to set the thickness.

Blur

Blurs the edges of the glow. Drag the slider to determine how much blur is applied.

Opacity

Specifies the opacity of the glow. Drag the slider to adjust the opacity of the glow. The
higher the opacity, the more visible the glow is.

Blend
Mode

Specifies how the effect blends with the text. Select a blend mode from the drop-down
menu.

Color

Specifies the color of the shadow. Click the color picker to select a different color.

Rotation

Specifies the angle of the shadow. Type a number from 0 to 359.9 or drag the arrow to
adjust the angle.

Blur

Blurs the edges of the shadow. Drag the slider to determine how much blur is applied.

Distance

Specifies the size of the shadow according to the rotation setting. Drag the slider to
adjust how far the shadow encroaches on your text.

Opacity

Specifies the opacity of the shadow. Drag the slider to adjust the opacity of the shadow.
The higher the opacity, the more visible the shadow is.

Elevatio
n

Specifies the visibility of the bevel effect. As you reduce the Elevation slider, the text
darkens, making the effect stand out more.

Radius

Specifies how spread out the bevel is.

Light
Source

Specifies an imaginary light source. Click and drag the glow on the ball to reposition the
imaginary light source.

Color

Specifies the color of the outline. Click the color picker to select a different color.

Thicknes
s

Specifies the thickness of the outline effect. Drag the slider to set the thickness.

Blur

Blurs the edges of the outline. Drag the slider to determine how much blur is applied.

Opacity

Specifies the opacity of the outline. Drag the slider to adjust the opacity of the outline.
The higher the opacity, the more visible the outline is.

Blur

Strength

Specifies the strength of the blur. Move the slider to the right to intensify the effect.

Shadow

Color

Specifies the color of the shadow. Click the color picker to select a different color.

Rotation

Specifies the angle of the shadow. Type a number from 0 to 359.9 or drag the arrow to
adjust the angle.

Blur

Blurs the edges of the shadow. Drag the slider to determine how much blur is applied.

Distance

Specifies the size of the shadow according to the rotation setting. Drag the slider to
adjust how far the shadow encroaches on your text.

Opacity

Specifies the opacity of the shadow. Drag the slider to adjust the opacity of the shadow.
The higher the opacity, the more visible the shadow is.

Inner
Shadow

Bevel

Outline

Fading text in and out
You can set your text to fade in and out with clips by adding transitions to your text.
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To add fading transitions to text:
1. With a clip added to the Timeline, click the Text tab or press T to see a list of Text Styles.
2. Select the Text Style you would like to use and drag it to your desired location on the Timeline. You can
also right-click on the Text Style you would like to use and click Apply or press Alt + A.
3. Click the Transitions tab or press S.
4. Select either Fade, Fade to Black or Fade to White transition, and drag it on to the text on your Timeline so it
lines up with the start and end of your text.
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Adding audio and voice recordings to your media
You can record narration or sounds using your microphone and incorporate them into your video project by
adding them to the Timeline.
To make a recording:
1. Click the Audio Recorder tab or press R.

2. Select your desired recording device from the drop-down menu.
3. To begin recording, press the Start Audio Recorder button.

4. To stop recording, press the Stop Audio Recorder button.

5. When prompted, enter a name for your clip and press Save. You will find your recorded clip in My Media.
To add your recorded clip to your project:

Page 38 of 76

ACDSee Luxea Video Editor User Guide

1. In My Media, do one of the following:
Right-click your recorded clip and select Add to Timeline at Playhead.
Select your recorded clip and press Alt + A.
Select your recorded clip and drag it onto your desired location on the Timeline.
To remove an audio clip from the Timeline:
Right-click the audio clip on the Timeline and select Delete from the context menu.
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Adjusting audio
You can add audio points to your audio clips on the Timeline to raise and lower the volume at your desired
intervals. You can also adjust audio independently or delete audio from video clips altogether. See Adding Audio
Effects to Your Video to learn how to quickly add a fade in at the beginning of your audio or a fade out at the end.
You can also control the speed of your audio using the Clip Speed effect.

To separate audio from video clips:
Right-click the clip on the Timeline and choose Separate Audio and Video from the context menu or select the
clip and press Alt + S. The audio will separate onto a different track above, allowing you to move it independently.
To raise or lower the volume of your audio clip:
1. Right-click the clip on the Timeline and choose Separate Audio and Video from the context menu.
2. The audio will separate onto a different track above. On the track with the audio, select the yellow line and
drag it up to raise the volume, or down to lower the volume.

As you raise or lower the volume, the level will snap to 100% as you near the center. To avoid this, hold
down Shift while raising or lowering the volume.

To add audio points to your audio clip:
1. At your desired location on the clip, right-click the audio clip and select Add Audio Point from the
context menu.
2. Continue to add as many audio points as you desire.
3. Select the audio point (dot) and drag up to raise the volume at that point, or drag down to lower the
volume at that point.

To remove audio from your video clip:
Right-click the clip on the Timeline and choose Remove Audio from Video from the context menu.
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Adding transitions to your media
Transitions are visual effects you can add between the end of one clip and the beginning of another. You can use
transitions to indicate changes in your video's narrative or to transition between video and still images.
To add transitions between your images or videos:
1. After you have placed two or more clips on the Timeline, click the Transitions tab or press S.

2. On the Transitions panel, select the transition you would like to use and drag it to where the two clips
meet on the Timeline. Alternatively, you can drag it to the beginning or the end of a clip.
If you add a transition at the end of a single clip, and then try to add the second clip, the transition will
only be visible during the end of the first clip and will not appear at all in the second.

To delete a transition:
Right-click the transition on the Timeline and choose Delete.
To change the duration of a transition:
Click the edge of the transition on the clip and drag it to specify the desired duration.
To switch from one transition to another:
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1. On the Timeline, select the transition on the clip and press the Properties button in the top right corner.
2. From the Type drop-down menu, select another transition.
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Adding audio effects to your media
You can add a fade in audio effect at the beginning of your video files. You can also add a fade out audio effect at
the end of your video files.
You can also control the speed of your audio using the Clip Speed effect.

To add an audio effect:
1. After you have placed one or more clips on the Timeline, click the Audio Effects tab or press D.

2. Select the audio effect you would like to use and drag it to the beginning or end of a clip, or to where two
clips meet on the Timeline.
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Adding animations to your media
You can use animations to transition your media's properties from one state to another. You can select pre-made
animations or create custom animations. For custom animations, you can control which visual properties are being
transformed, such as blend mode, opacity, rotation, position, and size. You can use the Restore animation to
restore your media to its previous settings after any animation. You can also add animations to text and edit the
sizing.
To add animations to your media:
1. After you have placed one or more clips on the Timeline, click the Animations tab or press A.

2. Drag an animation to your desired location on a clip on the Timeline. The animation will appear as an arrow
on the clip. Control the duration of the animation by dragging the arrow right or left. Media to the right of
the animation arrow will remain in this new state unless you add a Restore animation, or another
animation.
To restore your media:
1. After an animation has altered the visual properties of your clip, drag a Restore animation to a location to
the right of the animation. This will be the location where you would like the visual properties to be
restored.
2. The Restore animation will appear as an arrow on the clip. Control the duration of the Restore animation by
dragging the arrow right or left. To the right of the Restore animation, your previous settings will be
restored.
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To add custom animations to your media:
1. After you have placed one or more clips on the Timeline, click the Animations tab or press A.

2. Drag a Custom animation to your desired location on a clip on the Timeline. The animation will appear as
an arrow on the clip. Control the duration of the animation by dragging the arrow right or left.
3. Place the Playhead to the right of the Custom animation.

4. Press the Properties button.
5. Configure the visual properties you would like for your media's end state. These include properties such
as blend mode, opacity, rotation, and position.
6. To change the visual properties of your media prior to the animation, place the Playhead to the left of the
custom animation and customize the settings in the Properties pane.
To add animations to text and edit their sizing:
1. After you have placed one or more clips on the Timeline, click the Text tab or press T to see a list of Text
Styles.
2. Select the Text Style you would like to use and drag it to your desired location on the Timeline. You can
also right-click on the Text Style you would like to use and click Apply or press Alt + A.
3. A text box will open beneath the Display Area where you can edit the text displayed and its style. On the
right hand side, you will see settings where you can change font, color, size, style, Text Effects, direction,
and alignment.

Page 45 of 76

ACDSee Luxea Video Editor User Guide

4. Once you have finalized your text, click the Animations tab or press A.
5. Drag your desired animation onto your text on the Timeline. The animation will appear as an arrow on the
clip. Control the duration of the animation by dragging the arrow right or left. Media to the right of the
animation arrow will remain in this new state unless you add a Restore animation, or another animation.
6. At either the start or end of the arrow, use the text bounding box to set the scale of the text for the
animation. To do this, click on the edges of the bounding box and drag in or out to scale the box.
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Adding behaviors to your media
You can add behaviors to alter to look and feel of the beginning or end of your media. You can also add behaviors
that occur during your media.
To add behaviors to your media:
1. After you have placed one or more clips on the Timeline, click the Behaviors tab or press B.

2. Select the behavior you would like to use and drag it over a clip on the Timeline.
For a behavior that stylizes the entrance of your media, choose from the In tab at the top of the
Behaviors section. Applied behaviors from the In tab are indicated on your clip using the
following circle icons:
For a behavior that occurs during your media's run time, choose from the During tab. Applied
behaviors from the During tab are indicated on your clip using the following circle icons:
For a behavior that stylizes the exit of your media, choose from the Out tab. Applied behaviors
from the Out tab are indicated on your clip using the following circle icons:
Hover your cursor over the circle icons for a pop-up display of the behavior's start time and duration.
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Behavior settings
You can adjust the properties of each behavior you apply to your media.
To adjust behavior settings:
1. Display the behavior's properties by doing one of the following:
On the Timeline, select the clip and press the Properties button in the top right corner.
On the Timeline, right-click the clip and choose Show Properties.
2. Under Properties, adjust the behavior settings as described below.

Behavior
In/Out

During
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These tabs allow you to adjust settings for behaviors placed on the entrance and exits of your
media.
Style

You can use the Style drop-down menu to
change the behavior's style.

Movement

You can use the Movement drop-down menu to
customize the behavior's flow.

Speed

You can use the Speed slider to increase or
decrease the behavior's speed.

This tab allows you to adjust settings for behaviors set to occur during your media.
Style

You can use the Style drop-down menu to
change the behavior's style.

Movement

You can use the Movement drop-down menu to
customize the behavior's flow.

Loop Time

Set the amount of time for which the behavior
will loop.

Loops

Drag the slider to set the behavior's number of
loops.

Loop Forever

Check/uncheck this checkbox to control
whether the behavior loops indefinitely.
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Adding filters to your media
You can add filters to alter the look of your images or videos.
To add filters to your image or video:
1. After you have placed one or more clips on the Timeline, click the Filters tab or press L.

2. Select the filter you would like to use and drag it over a clip on the Timeline. A note stating "Effect Added"
will temporarily appear on the Timeline.
To adjust the duration of a filter:
You can configure the amount of time your clip is affected by filters.
1. Select the clip on the Timeline with the filter applied and click the bar at the bottom of the clip.
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2. Drag the edges of the filter on the clip to change its duration.

To adjust the timing of a filter:
You can configure when your clip is affected by filters.
1. Select the clip on the Timeline with the filter applied and click the bar at the bottom of the clip.

2. Drag the edge of the filter on the clip to change its duration. Then drag the filter left or right to specify
your desired start and finish times.

To copy and paste a filter from one media to another:
1. With the filter selected on the Timeline, right-click and select Copy Selected Filter.
2. On the destination media, right-click and select Paste Filters. A note stating "Effect Added" will
temporarily appear on the Timeline.
Or:
1. With the media containing the filter selected on the Timeline, go to Edit | Copy Filters.
2. Select the destination media, go to Edit | Paste Filters. A note stating "Effect Added" will temporarily
appear on the Timeline.

Filter settings
You can adjust the properties of each filter you apply to your media.
To adjust filter settings:
1. Display the filter's properties by doing one of the following:
On the Timeline, right-click the filter on the clip and choose Show Properties.
On the Timeline, select the filter on the clip and press the Properties button in the top right corner.
2. Under Properties, adjust the filter settings as described below.
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Black & White filter options
Adjust the Red, Green, or Blue sliders to add color back into the black and white image or video.
Brightness

Adjusts the brightness of the colors in the image or video.

RGB filter options
Adjust the Red, Green, or Blue sliders to balance or heighten the RGB channels in the image or video.

Exposure filter options
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Exposure

Drag the slider to the right to increase exposure, or drag to the left to
decrease exposure.

Contrast

Drag the slider to the right to increase contrast, or drag to the left to
decrease contrast.

Photo Effect filter options
Select a photo effect from the drop-down menu to change the look and feel of your image or video.

Blur filter options
Select the Gaussian Blur or Directional Blur button to select the type of blur.
Gaussian Blur

Produces an even, smooth blur.
Strength

Directional Blur

Specifies the strength of
the blur. Move the slider to
the right to intensify the
effect.

Produces a blurring effect that gives the illusion of movement.
Strength

Specifies the strength of
the blur. Move the slider to
the right to intensify the
effect.

Angle

Specifies the direction of
the blur effect.

Light EQ™ filter options
Brighten

Drag the slider to the right to increase the brightness of dark areas in
your image or video.

Darken

Drag the slider to the right to decrease the brightness of light areas in
your image or video.

Sharpen filter options
Strength

Specifies the strength of the sharpening applied by increasing contrast
around edges.

Radius

Controls the number of pixels to adjust around each edge. Higher
values increase the number of sharpened pixels and tend to bring out
coarser detail, while lower values reduce the number of sharpened
pixels and tend to bring out finer detail.

Detail

Suppresses the halo, (the light border that forms around edges with
extreme sharpening), by reducing its intensity. The higher the value,
the stronger the reduction.

Threshold

Specifies how different the pixel lightness values within an edge must
be before the pixels within the edge are sharpened. Higher values
sharpen only stronger edges but minimize the appearance of noise.
Lower values sharpen both strong and weaker edges, but can increase
the appearance of noise. We recommend you set the threshold to
enhance edges while keeping background noise to a minimum.

Vibrance filter options
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Vibrance

Drag the slider to the right to increase vibrance, or to the left to
decrease vibrance. Increasing vibrance does not affect skin tone in an
image or video.

Saturation

Drag the slider to the right to increase saturation, or to the left to
decrease saturation.

Hue

Adjusts the hue of the image or video. Drag the slider to the right to
increase or drag to the left to decrease hue.

Lightness

Adjusts the image or video brightness. Drag the slider to the right to
increase or drag to the left to decrease the image or video's brightness.

Vignette filter options
Strength

Specifies the size and intensity of the vignette.

Distance

Specifies the size of the clear area around the focal point in the
portrait. Drag the slider to the left to reduce the size of the clear area.
Drag the slider to the right to increase the size of the clear area.

Shape

Specifies the shape of the frame.

White Balance filter options
Temperature

Adjusts the warmth of the correction, from blue to yellow.

Tint

Adjusts the tint of the correction, from green to magenta.

Reflection filter options
Height

Drag the slider to set the height of the reflection.

TV Wall filter options
Number of TVs

From the drop-down menu, select the number of "TVs" to display.

Vertical Divide filter options
Divisions

From the drop-down menu, select the number of times to divide your
image or video.

Partial Mosaic filter options
Width

As you increase the Width, the blocks will fill in from the left and right.

Height

As you increase the Height, the blocks will fill in from the top and
bottom.

Degree

Drag the slider to adjust the size of the blocks.

Emboss filter options
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Elevation

Specifies the light source's elevation on the image or video. Lower
values produce more shadows and a darker image or video. Higher
values produce fewer shadows and a lighter image or video.

Azimuth

Specifies the amount of relief added to the image or video. Higher
values increase the relief depth.

Weight

Specifies the angle of shadows that extend from the edges of image or
video details. A value of 0 adds shadows to the left side, while a value of
180 adds shadows to the right side.

Hue Shift filter options
Hue

Drag the slider to change the hues of the colors in your image or video.

Morphology filter options
Width

Specifies the width of each bar.

Height

Specifies the height of each bar.

Mirror filter options
Horizontal

Choose an orientation for the mirror's axis.

Vertical
Axis

Drag the slider to adjust the position of the mirror's axis.

Color Fence filter options
Degree

Drag the slider to change the number and relative width of color bars to
appear on your image or video.

Four Seasons filter options
Horizontal

Choose an orientation for the color bars on your image or video.

Vertical

Shake filter options
Degree

Specifies the strength of the pulse.

Pane filter options
Width

Blur Background filter options
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Specifies the width of the color bar that moves across the video.
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Select the Gaussian Blur or Directional Blur button to select the type of blur.
Gaussian Blur

Produces an even, smooth blur.
Strength

Directional Blur

Specifies the strength of
the blur. Move the slider to
the right to intensify the
effect.

Produces a blurring effect that gives the illusion of movement.
Strength

Specifies the strength of
the blur. Move the slider to
the right to intensify the
effect.

Angle

Specifies the direction of
the blur effect.

Linear Gradient filter options
Start Color

Use the Colors pop-up to select the precise color you would like the
Linear Gradient filter to start with. On the far right is a vertical color
slider, which you can use to navigate to a color group. When you
choose a color, that color displays its numerical values in the Red,
Green, and Blue fields, as well as the Hex field. You can enter precise
values to get specific colors. You can also use the Color Dropper tool to
pick specific colors for your media.

End Color

As above, use the Colors pop-up to choose the color you want to end the
gradient with.

Horizontal

Choose an orientation for the Start Color and End Color.

Vertical

Jigsaw filter options
Color 1, Color 2, Color 3, Color 4

You can use the Colors pop-up to select precise colors you want each
portion of your media to change hues to. On the far right is a vertical
color slider, which you can use to navigate to a color group. When you
choose a color, that color displays its numerical values in the Red,
Green, and Blue fields, as well as the Hex field. You can enter precise
values to get specific colors. You can also use the Color Dropper tool to
pick specific colors for your media.

Opacity

Use the Opacity slider to change the opacity of the Jigsaw effect.

Chromatic Aberration filter options
Degree
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Drag the slider to adjust the amount the colors shift when playing your
project.
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Adding overlays to your media
Overlays are visual effects you can add on top of or after your media.
To add overlays to your images or videos:
1. After you have placed one or more clips on the Timeline, click the Overlays tab or press O.

2. Select the overlay you would like to use and drag it to your desired location on the Timeline. You can place
it before or after your media, or during by adding it to another track above your media.
To delete an overlay:
Right-click the overlay on the Timeline and choose Delete.
To change the duration of an overlay:
Click the edge of the overlay and drag it to specify the desired duration.
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Adding captions to your media
You can add captions to your video. This is useful for including information, subtitling, adding comments, and
much more.
To add a caption to your video:
1. Click the Captions tab or press C.

2. On the Captions panel, press the Add button.
Playhead on the Timeline.

Or press Shift + C. The caption will be added at the

3. In the field under the Display Area, type the text you want to add.
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The box on the left of the Text field indicates the time that the text will appear. Move the text on the
Timeline as desired.

4. Click the Text Style drop-down menu to adjust the text style options. Configure options, such as font,
background color, text alignment, and any bold or italics you want to include.
Changes made to Text Style only affect the selected text. Changes made to Global Properties affect
Captions throughout the project. For example, you can italicize certain words and it won't affect
others, but changing the Caption font will affect all captions.
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To bold, italicize, or underline a particular section of a caption, select the text in the Text field and
press the Bold, Italics, or Underline button(s).

5. On the Timeline, move or extend the caption by clicking and dragging it.
To remove a caption from the Timeline:
To remove a caption from the Timeline, right-click the caption on the Timeline and select Delete from the context
menu.
To remove all captions from the Timeline:
Go to Edit | Remove all Captions or click Ctrl + Alt + S.
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Adding advanced effects to your media
You can use the tools on the Advanced Effects tab to fine-tune and further customize your media.

Chroma Key
Chroma Key is an effect that lets you remove a solid color from the background of your media. This is most often
put to use with video shot with a green screen, which facilitates your ability to add a different background of your
choosing.
To remove a color from your media:
1. After you have placed one or more clips on the Timeline, click the Advanced Effects tab or press E.

2. Select Chroma Key and drag it onto your clip on the Timeline. A note stating "Effect Added" will
temporarily appear on the Timeline.
3. With the clip selected, on the Chroma Key section of the Properties pane, adjust the settings as described
below.

Chroma Key options
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Color

You can use the Colors pop-up to select precise colors to remove from your
media. To open this, click on the Color drop down menu.
On the far right is a vertical color slider, which you can use to navigate to a
color group. When you choose a color, that color displays its numerical values
in the Red, Green, and Blue fields, as well as the Hex field. You can enter
precise values to get specific colors. You can also use the Color Dropper tool to
pick specific colors from your media.

Tolerance

Adjust the slider to define how similar a color must be to the selected color in
order to be removed.

Softness

Adjust the slider to soften the edge between the color being removed and what
is left. Softness also reduces the overall opacity of the image.

Invert Settings

Check the Invert Settings checkbox to remove every color except your
selected color.

Color LUTs
"Color LUT" stands for Color Lookup Table. Color LUTs are lists that instruct Luxea to map specific RGB values to
other specific color values. You can import LUTs and use them as filters in Luxea. Color LUT supported file types
are .3dl and .cube.
To apply a Color LUT to your media:
1. After you have placed one or more clips on the Timeline, click the Advanced Effects tab or press E.
2. Select Color LUTs and drag it onto your clip on the Timeline. A note stating "Effect Added" will
temporarily appear on the Timeline.
3. With the clip selected, on the Color LUTs section of the Properties pane, do one of the following:
Select a LUT from the Color LUTs drop-down menu in the Properties pane.
Press the Load LUTs button. In the Open dialog, browse to the location of your LUT files, and press
Open. The LUT is immediately applied.
To remove Color LUTs from the Color LUTs drop-down menu:
In order to remove a Color LUT from the list of available LUTs, you must first have a LUT applied.

1. In the Color LUTs section of the Properties pane, select the LUT you want to remove from the list.
2. Press Remove.
3. Press Yes to confirm.

Clip Speed
You can use the Clip Speed effect to control the speed and overall duration of your audio and video files.
To speed up or slow down your media:
1. After you have placed one or more clips on the Timeline, click the Advanced Effects tab or press E.
2. Select Clip Speed and drag it onto your clip on the Timeline or select the clip and press Alt + C. A note
stating "Effect Added" will temporarily appear on the Timeline.
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3. With the clip selected, on the Clip Speed section of the Properties pane, configure the settings as
described below.

Clip Speed options
Speed

Decrease your clip's speed by reducing the value in this field below 1.00.
Increase your clip's speed by increasing the value in this field above 1.00.

Minutes/Seconds

Set your clip's desired duration using minutes or seconds.

Frames

You can use the Frames field to fine-tune the speed and duration of your media.

Audio Speed
You can also use the Clip Speed effect to control the speed and overall duration of audio only.
To speed up or slow down your audio:
1. Right-click your clip on the Timeline and choose Separate Audio and Video from the context menu, or
press Alt + S.
2. Click the Advanced Effects tab or press E.
3. Select Clip Speed and drag it onto your audio clip on the Timeline or select the clip and press Alt + C.
4. With the audio clip selected, on the Clip Speed section of the Properties pane, configure the settings
described in the "Clip Speed options" on page 62.

Mosaic
You can blur out specific areas of your media. This is useful for covering sensitive information or providing
anonymity to individuals in your media.
To add a mosaic effect to your media:
1. After you have placed one or more clips on the Timeline, click the Advanced Effects tab or press E.
2. Select Mosaic and drag it onto a track on the Timeline.
3. With Mosaic selected, on the Mosaic section of the Properties pane, configure the settings as described
below.

Mosaic options
Blend Mode

You can use blend modes to control how the Mosaic effect impacts the final
image when the opacity is changed.

Opacity

The Opacity slider changes the opacity of the Mosaic effect. It gives you control
over how distinct the Mosaic effect appears on the media. You can then use a
blend mode to customize it further.

Rotation

Enter a value in the field or drag the arrow handles to rotate the Mosaic effect
by the X, Y, or Z axes.

Degree

You can use the Degree slider to control how blurred the Mosaic effect is.
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Color Pass
Color Pass lets you isolate certain colors within your media and revert all others to black and white. This can help
you draw the eye to a certain part of a clip, for example, the pink cherry blossoms on a tree. The cherry blossom
flowers will show up as pink, and the rest of the image would be black and white.
To add Color Pass:
1. After you have placed one or more clips on the Timeline, click the Advanced Effects tab or press E.
2. Select Color Pass and drag it onto your clip on the Timeline. A note stating "Effect Added" will temporarily
appear on the Timeline.
3. With the clip selected, on the Color Pass section of the Properties pane, adjust the settings as described
below.

Color options
Color

You can use the Colors pop-up to select precise colors to focus on or invert
within your media. On the far right is a vertical color slider, which you can use
to navigate to a color group. When you choose a color, that color displays its
numerical values in the Red, Green, and Blue fields, as well as the Hex field.
You can enter precise values to get specific colors. You can also use the Color
Dropper tool to pick specific colors from your media.

Similarity

Adjust the slider to define how similar a color must be to the selected color in
order to be affected.

Invert Settings

Check the Invert Settings checkbox to remove your selected color and leave
every other color.

Replace Color
Replace Color lets you select certain colors within your media and replace them with a different color.
To add the Replace Color effect to your media:
1. After you have placed one or more clips on the Timeline, click the Advanced Effects tab or press E.
2. Select Replace Color and drag it onto a clip on the Timeline.
3. With the clip selected, on the Replace Color section of the Properties pane, configure the settings as
described below.

Replace Color options
Target Color

You can use the Colors pop-up to select precise colors to replace. On the far
right is a vertical color slider, which you can use to navigate to a color group.
When you choose a color, that color displays its numerical values in the Red,
Green, and Blue fields, as well as the Hex field. You can enter precise values to
get specific colors. You can also use the Color Dropper tool to pick specific
colors for your media.

Replace Color

As above, choose a color to replace your target color with.

Similarity

Adjust the slider to define how similar a color must be to be the selected color
in order to be affected.

Solid Colors

Check this box to change the Target Colors to the Replace Color and remove any
light/dark shadows. When this box is unchecked, the target color will be
replaced but the light/dark image variations will remain.
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Adjusting media duration and making freeze frames
When you add media to the Timeline, it will automatically be placed at certain intervals and at set durations. You
can change the duration of the media and the gaps between media by changing the duration settings. This allows
you to blend images into one another without the screen going black in between, or it allows you to end a scene
with a black screen for a certain duration before the next one begins.

Adjusting the duration of video or audio.
To change media duration:
1. Select the media you wish to edit on the Timeline.
2. Hover over the start or end of the media, click and drag the double arrows adjust the length. The format is
(hours:minutes:seconds;frames).

Adjusting the duration of text, images, overlays, captions and mosaics.
To change media duration:
1. Select the media you wish to edit on the Timeline.
2. Right-click and choose Duration... from the context menu to open the Duration dialog.
3. Choose a Duration using the up or down arrows or by entering a duration in the Duration field. The format
is (hours:minutes:seconds;frames).
4. Press OK.

Using Ripple Edit duration
Ripple Edit duration is a setting that maintains gaps between media in your project. By default, Ripple Edit
duration is enabled. This allows you to change the duration of media without changing the gaps you have created
after it. For example, you have an image, followed by a four second gap, then a video clip. If you then lengthen the
duration of the image, with Ripple Edit duration enabled, it will not reduce the four second gap that follows it.
Without this feature enabled, by extending the duration of the image, it would reduce the duration of the following
gap.
To disable Ripple Edit when making changes to duration, uncheck the Ripple Edit box in the Duration dialog.

Freeze frames
You can extend the duration of specific frames of your media as a freeze frame.
When you add a freeze frame to your media, the clip you have selected will expand to the duration you
choose. Therefore, Freeze Frame will not be enabled in the context menu unless there is space on the
Timeline to the right of your clip.
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To create a freeze frame:
1. With your desired media on the Timeline, place the Playhead on the frame of your video you would like to
capture, right-click and choose Freeze Frame from the context menu or press Alt + F.
2. From the Freeze Frame dialog, set how many seconds you would like your freeze frame to last.
3. Press OK. Your freeze frame will be added to your media on the Timeline.
You can adjust Clip Speed as well as clip duration. Find more about this in the Advanced Effects topic.
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Creating still images from your clips
You can take snapshots of your video's playback and add them to My Media.

Snapshots
You can take snapshots of your video's playback at any time.
To create a snapshot:
1. With your desired media on the Timeline, press the Play button below the Project Display Area.

2. At your desired frame, press the Snapshot button or press Shift + S.
noting the hard drive location where your snapshot has been saved.

A dialog box will appear

3. Press OK.
To change the location of your saved snapshots, and configure snapshot settings, see Options and configuration.
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Using Content Packs to enhance your media
You can download Content Packs from ACDSee to further enhance your media. These packs can contain images,
video, audio, Text Style presets, fonts, behaviors, and overlays. First, you will need to download a Content Pack
from the ACDSee website. Once imported, you will find Content Pack contents in the Library tab.
To download Content Packs, do one of the following:
Visit the ACDSee website.
Click on the download button in the top right of Luxea.
Click on the download button in the bottom right of the Library tab.
To add Content Packs to your Library:
1. Go to File | Import | Content Pack...
2. In the Add Content Packs dialog, choose the Content Pack files (.alcp) you want to import.
3. Press OK.
Or:
1. Navigate to the folder where you downloaded your Content Packs to.
2. Double-click on the Content Pack files (.alcp) and they will open in Luxea.
Or:
1. Open the Library tab.
2. Click on the Import Content Pack icon.
To add Content Packs to your Library with Luxea closed:
1. Navigate to the folder where you downloaded your Content Packs to.
2. Right-click on the Content Pack files (.alcp). Select Open with ACDSee Luxea.
To add content from Content Packs to your Timeline:
1. After you have placed one or more clips on the Timeline, open the Library tab.
2. Drag the relevant enhancement from the Library to your chosen point on the Timeline.
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Options and configuration
You can configure options to customize and automate Luxea's functionality.
To configure options:
1. Go to Tools | Options..., or press Alt + O.
2. Configure the options as described in the table below.
3. Press OK.

Options Dialog Box
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General
Duration

Transitions: set how long you would like your transitions to display.
Images: set how long you would like your image to display.
Captions: set how long you would like your captions to display.
Animations: set how long you would like your animations to display.
Freeze Frames: set how long you would like your freeze frames to display.
Mosaics: set how long you would like your Mosaics to display.
Text: set how long you would like your text to display.
The format for the duration is hours, minutes, seconds; frames.

Watermark

Snapshots

Advanced
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Enable
watermark

Check this checkbox to include a watermark on your video.

Watermark

Browse to find the image you would like to use for your watermark.

Position

Select a square to indicate your desired position for your watermark
on the video image.

Opacity

Use the slider to change the opacity of your watermark. By default,
your watermark is 100% opaque, which means that you cannot see
through it. As you reduce the opacity, the watermark becomes more
and more transparent. A watermark with an opacity of zero is
completely transparent.

Snapshot
Location

Displays the location of your saved snapshots. Click the Browse
button to specify a new location on your hard drive.

Add snapshots
to My Media

Checked by default, this option automatically adds your snapshots to
the media available in My Media. From here, you can easily drag them
onto your Timeline.

Enable
snapshot
sound

Checked by default, this option will play a sound whenever you take a
snapshot.

Temporary
Storage Folder

The Temporary Storage Folder stores the media you have in the
Library while you are working on your project. The Temporary
Storage Folder is cleaned up after you save your project, and will
empty once you produce the project.

Hardware
Acceleration

Enable Hardware
Acceleration

Enabled by default, this option
ensures that the encoding process
will be undertaken by your graphics
card, rather than your CPU. This will
accelerate the media rendering
process. If presented with multiple
graphics cards, Luxea will prioritize
hardware acceleration options using
the following hierarchy: NVIDIA,
Intel® Quick Sync.

AutoSave

Enable AutoSave

This option will automatically save
your projects as often as you
indicate. When you restart Luxea
after an unexpected shutdown, it
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will recover your project and open it
in its state as of the most recent
save point.
Interval ... minute(s)

Indicate how often you would like to
automatically save.

Default
playback
quality

Choose a playback quality from Full to 1/16. This can speed up your
editing process if you are working with high quality videos or your
computer is processing the video slowly.

Load project to
fit Timeline.

Load project zoomed out so all elements are visible on the Timeline.

Default
Project
Settings

Display Area Dimensions

You can set the Display Area size
that Luxea loads as default every
time you open it. You can choose
preset dimensions for TikTok and
Instagram here.

Width

Enter a custom width for the Display
Area, which Luxea will open as
default.

Height

Enter a custom height for the
Display Area, which Luxea will open
as default.

Frame Rate

Choose a frame rate from 23.97
frames per second (fps) to 60 fps.

Prompt if media
dimensions or frame rate
do not match project
settings.

Luxea will prompt you if media
dimensions or frame rate do not
match the Display Area dimensions
or project frame rate.

Always match project
settings to imported
media dimensions and
frame rate.

You can set Luxea to adjust the
Display Area size to match the
dimensions of your media and the
project frame rate to match the
media frame rate automatically.

Display
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Producing and sharing your media
When you have finished editing your project, you can use the Produce and Share function to finalize and distribute
your videos. This final stage of the production process creates an output file from the arranged media and effects
on the Timeline. The production process allows you to choose video and audio parameters for your output file, as
well as the option of sharing the output to YouTube, Vimeo, Facebook, and Twitter.
You can produce an output file from the entirety of the media on the Timeline or a selection.
Video productions will not include media on tracks that are disabled.

Video productions will not include media moved outside of the Display Area.

To produce an output file from the media on the Timeline:
1. To produce your video, open the Production Assistant using one of the processes below:

Press the Produce and Share button in the top right corner.
Go to File | Produce and Share...
Press Ctrl + P.
2. Sign in to acdID, or create an account.
3. Follow the directions under To configure the output file in the Production Assistant.
To produce a GIF:
To produce a GIF, do one of the following:

1. Click the Project Settings button at the top of the Display Area.
2. From the Project Settings dialog, select GIF Size (480x270) from the Project Settings drop-down
menu. This size allows for easy sharing.

3. Press the Produce and Share button in the top right corner.
4. Sign in to acdID, or create an account.
5. Continue as described under To configure the output file in the Production Assistant.
Or:
1. In the Production Assistant, from the Output Format drop-down menu, select GIF.
2. We recommend that you select 480x270(GIF) from the Video Frame Size drop-down menu. This size
allows for easy sharing.
3. Continue as described under To configure the output file in the Production Assistant.
To produce a TikTok or Instagram video:
Instagram TV (or IGTV) uses the same dimensions as TikTok, so if you're producing a video for IGTV, use
the TikTok (1080x1920) preset dimensions.
To produce a video optimized for these social channels, do one of the following:
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1. Click the Project Settings button at the top of the Display Area.
2. From the Project Settings dialog, select TikTok (1080x1920) or Instagram (1080x1080) from the
Project Settings drop-down menu.

3. Press the Produce and Share button in the top right corner.
4. Sign in to acdID, or create an account.
5. Continue as described under To configure the output file in the Production Assistant.
Or:
1. In the Production Assistant, from the Output Format drop-down menu, choose 1080x1920 for TikTok
and 1080x1080 for Instagram.
2. Continue as described under To configure the output file in the Production Assistant.
To produce an output file from a Selection:
With your selection made on the Timeline, go to File | Produce Timeline Selection as...
To configure the output file in the Production Assistant:
For sharing to YouTube, see the Sharing section below.
1. In the Production Assistant, select your desired Output format from the drop-down menu.
2. Click the Detailed Settings button to alter additional video and audio parameters, as described in the
table below.

Detailed Settings dialog box
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Format

Displays your output format.

Video Parameters

Codec

Video codec specifies the type of video data compression you
would like Luxea to use.

Size

By default, the video image size will reflect the current settings of
the Display Area Dimensions. To change the size, select the video
image size, or choose Custom to specify a unique width and
height.

Bitrate

Select the bitrate to determine how much data will go to the screen
per second of playback. A higher bitrate allows for a higher quality
picture, however, it also increases the file size.
Setting the bitrate above High (30000 kbps) may increase
the file size with no apparent visual improvement to the
quality.
Only applicable for GIF format.

Loops

You can uncheck the Loop Forever checkbox and then set the
number of times your GIF will loop.

Audio Parameters

Frame
rate

Select the frame rate to determine how quickly the picture
refreshes.

Codec

Codec specifies the type of audio data compression you would like
Luxea to use.

Sample
rate

Sampling describes the data rate of a sound recording. A higher
sample rate allows for higher quality sound, however, it also
increases the file size.

Channel

From the drop-down menu, select 1 to have the same sound come
out of the left and right speakers, or, 2, to have different sound
come out of the left speaker versus the right.

Bitrate

Select the bitrate to determine how much audio data will go to the
speakers per second of playback. A higher bitrate allows for a
higher quality sound, however, it also increases the file size.

3. Click OK.
4. Click Next.
5. In the Name field, enter a name for your output file.
6. In the Folder field, press the Browse button to find the folder you want your output file to be placed in.
7. Press Produce. Your video will render.
8. Press Finish to return to Luxea.

Sharing
To share to YouTube:
You can upload your video content to YouTube to share privately with friends or publicly with the YouTube
community.
1. In the Production Assistant, select Share to YouTube from the Output Type drop-down.
2. Configure your settings as described above, then press Next.
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3. In the Name field, enter a name for your output file.
4. In the Folder field, press the Browse button to find the folder you want your output file to be placed in.
5. Press Next.
6. In the YouTube Login pop-up, enter your username and password. Follow the prompts, and press the
Allow button to authorize Luxea to upload your media file to your account.
7. In the Production Assistant, under Enter Video Information, fill in the fields, as described in the table
below.
8. Press Produce. Your video will be uploaded to YouTube as soon as the rendering is complete. If you have
opted to share your video link on Facebook or Twitter, they will now open in your browser and prompt you
to enter your username and password.
9. Navigate to YouTube.com to see or share your video.

Production Assistant dialog box
Enter Video Information

Title

Enter a title for your video.

Description

Enter a description of your video.

Tags

Enter tags you would like to assign to your video.
These tags will help to determine when your video
shows up in searches on YouTube.

Category

From the drop-down menu, select the category you
would like your video to be listed under on YouTube.

Private

Check the Private checkbox if you want your video
to be visible only to you.

Share YouTube link on
Facebook

Check the Share YouTube link on Facebook
checkbox if you want to share a link to your video on
Facebook. After you have uploaded your video to
YouTube, Facebook will open and you will be
prompted to enter your Facebook username and
password.

Share YouTube link on
Twitter

Check the Share YouTube link on Twitter
checkbox if you want to share a link to your video on
Twitter. After you have uploaded your video to
YouTube, Twitter will open and you will be prompted
to enter your Twitter username and password.

To share to Vimeo:
You can upload your video content to Vimeo.
1. In the Production Assistant, select Share to Vimeo from the Output Type drop-down.
2. Configure your settings as described above, then press Next.
3. In the Name field, enter a name for your output file.
4. In the Folder field, press the Browse button to find the folder you want your output file to be placed in.
5. Press Next.
6. In the Vimeo Login pop-up, enter your login credentials. Follow the prompts.
7. In the Production Assistant, under Enter Video Information, fill in the fields, as described in the table
below.
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8. Press Produce. Your video will be uploaded to Vimeo as soon as the rendering is complete. If you have
opted to share your video link on Facebook or Twitter, they will now open in your browser and prompt you
to enter your username and password.
9. Navigate to Vimeo.com to see or share your video.
Enter Video Information

Page 75 of 76

Title

Enter a title for your video.

Description

Enter a description of your video.

Tags

Enter tags you would like to assign to your video.
These tags will help to determine when your video
shows up in searches on Vimeo.

Privacy

Select a privacy setting from the drop-down menu.
Please note that if you select Password, you will
need to type a password in the provided field below.

Share Vimeo link on
Facebook

Check the Share Vimeo link on Facebook
checkbox if you want to share a link to your video on
Facebook. After you have uploaded your video to
Vimeo, Facebook will open and you will be prompted
to enter your Facebook username and password.

Share Vimeo link on
Twitter

Check the Share Vimeo link on Twitter checkbox
if you want to share a link to your video on Twitter.
After you have uploaded your video to Vimeo, Twitter
will open and you will be prompted to enter your
Twitter username and password.
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Your acdID account
To publish and share videos, or to upgrade your license, you will need an acdID account. Your acdID account also
grants you access to the acdID User Portal, where you can manage your software and subscriptions, watch video
tutorials, and get software support.

Creating an acdID account
To create an acdID account:
1. Click on the user icon in the top menu bar in Luxea

.

2. In the Luxea dialog, click Sign Up.
3. Follow the on screen instructions to finish creating your account.

Upgrading your license
In the Luxea Free Plan, you can produce videos with a watermark or an intro/outro, depending upon the video
length. To produce a video without the watermark or intro/outro, you will need to upgrade your license from the
Free Plan.
To upgrade your license from within Luxea:
1. Click on the user icon in the top menu bar in Luxea

.

2. In the Luxea dialog, log in, and click Upgrade.
3. Choose the plan that is right for you, and click Buy Now.
Or:
1. Click on the shopping cart icon in the top menu bar in Luxea
2. Choose the plan that is right for you, and click Buy Now.
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